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1 Important Comments 
To ensure fast installation and start-up of the units described in this manual, 
we strongly recommend that the following information and explanations are 
carefully read and abided by. 

1.1 Legal Principles 

1.1.1 Copyright 

This manual is copyrighted, together with all figures and illustrations 
contained therein. Any use of this manual which infringes the copyright 
provisions stipulated herein, is not permitted. Reproduction, translation and 
electronic and photo-technical archiving and amendments require the written 
consent of WAGO Kontakttechnik GmbH & Co. KG. Non-observance will 
entail the right of claims for damages. 

WAGO Kontakttechnik GmbH & Co. KG reserves the right to perform 
modifications allowed by technical progress. In case of grant of a patent or 
legal protection of utility patents all rights are reserved by WAGO 
Kontakttechnik GmbH & Co. KG. Products of other manufacturers are always 
named without referring to patent rights. The existence of such rights can 
therefore not be ruled out. 

1.1.2 Personnel Qualification 

The use of the product detailed in this manual is exclusively geared to 
specialists having qualifications in PLC programming, electrical specialists or 
persons instructed by electrical specialists who are also familiar with the valid 
standards. WAGO Kontakttechnik GmbH & Co. KG declines all liability 
resulting from improper action and damage to WAGO products and third party 
products due to non-observance of the information contained in this manual. 

1.1.3 Intended Use 

For each individual application, the components supplied are to work with a 
dedicated hardware and software configuration. Modifications are only 
permitted within the framework of the possibilities documented in the 
manuals. All other changes to the hardware and/or software and the non-
conforming use of the components entail the exclusion of liability on part of 
WAGO Kontakttechnik GmbH & Co. KG. 

Please direct any requirements pertaining to a modified and/or new hardware 
or software configuration directly to WAGO Kontakttechnik GmbH & Co. 
KG. 
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1.2 Symbols 

 

Danger 
Always abide by this information to protect persons from injury. 

 

Warning 
Always abide by this information to prevent damage to the device. 

 

Attention 
Marginal conditions must always be observed to ensure smooth operation. 

 

ESD (Electrostatic Discharge) 
Warning of damage to the components by electrostatic discharge. Observe the 
precautionary measure for handling components at risk. 

 

Note 
Routines or advice for efficient use of the device and software optimization. 

 

More information 
References on additional literature, manuals, data sheets and internet pages 
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1.3 Font Conventions 

Font type Indicates 

italic Names of path and files are displayed in italic, 
e.g.: C:\programs\WAGO-IO-CHECK 

Menu Menu options are displayed in bold, 
e.g.: Save 

> A greater-than sign between two names means the selection of a menu 
option from a menu,  
e.g.: File > New 

Input Designation of input or optional fields are displayed in bold, 
e.g.: Start of measurement range 

�Value� Input or selective values are displayed in inverted commas, 
e.g.: Enter the value �4 mA� under Start of measurement range. 

[Button] Button names in dialog boxes are displayed in bold in square brackets, 
e.g.: [Input] 

[Key] Names of keys on the keyboard are displayed in bold in square brackets, 
e.g.: [F5] 

 

1.4 Scope 
This manual describes the following components: 

Components 

BACnet Configurator for the Configuration of WAGO BACnet/IP Controllers 750-830 
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2 General 
This chapter describes the system requirements and the installation of the 
BACnet Configurator as well as the BACnet Service for accessing BACnet/IP 
Networks.  

Here, a BACnet/IP Network is a network consisting of one or more IP subnets 
containing BACnet devices. 

2.1 System Requirements 
Minimum system requirements: 

Operating system Windows 2000/XP/Vista 

Memory 128 MB 

Free hard disk storage 10 MB for the BACnet Configurator and  
280 MB (x86) or 610 MB (x64) for the .NET 2.0 Framework 

Monitor resolution  800 x 600 or greater 

Drive  CD drive for installation of CD 

Other Installed network card, .NET 2.0 Framework (redistributable included 
in delivery), network cable or hub 

 

2.2 Installation of the BACnet Configurator and Service 
The BACnet Configurator is installed on a PC that is connected to a 
BACnet/IP network through a switch, hub or router. 

The BACnet/IP Controller has two ports available � a serial 9-pole Sub-D port 
(RS232) and an RJ45 port. The BACnet/IP Controller is linked directly to the 
BACnet/IP Network through the RJ45 port. In addition to BACnet/IP, the 
Controller also supports the BACnet/PTP Protocol. The Controller can 
communicate with other PTP-capable devices through a modem connection in 
the RS232 interface (half router).  

 

Additional Information 
The WAGO BACnet Configurator is a component of the product "BACnet/IP 
Controller 750-830". You can download the software from the Internet site 
http://www.wago.com under Service ! Downloads ! BACnet Downloads. 

 

http://www.wago.com/
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1. Double click on the file "setup.exe" in the installation directory to start the 
installation. 

2. Click on [Next] to start the next installation step (see Fig. 2-1). 

 
Fig. 2-1: Start installation 

3. Read the terms of the license carefully and select  
[I Agree]. Start the next installation step by clicking on [Next] (see Fig. 
2-2). 

 
Fig. 2-2: Confirm the license agreement 
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4. Enter the path under which you would like to install the Configurator and 
choose whether the software is to be installed for every user ("Everyone") 
or only for yourself ("Just me") (see Fig. 2-3). 

 
Fig. 2-3: Choose the installation location 

5. Confirm further installation by clicking on [Next] (see Fig. 2-4). 

 
Fig. 2-4: Continue installation 
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The Configurator is installed (see Fig. 2-5). 

 
Fig. 2-5: Continue installation 

In addition to the BACnet Configurator, a BACnet Service (BACstac) is 
automatically installed in the background. During the installation of the 
service, protocol drivers are inserted in every (!) existing network connection, 
providing access to a BACnet/IP Network for the BACnet Configurator.  

 

Note 
Searching for network participants and their configuration in the BACnet 
Configurator is not possible without installing BACstac. 

 

Note 
The service may be blocked during installation by a firewall. If necessary, 
accept the BACnet Service manually in the firewall rules since this never 
happens automatically.  
If, in spite of this, the BACstac is not automatically installed, proceed as 
described in section 2.2.1 and install the BACstac manually. 

 

Note 
An active network connection is required to use the BACstac. 
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The properties of the installed BACnet Service are displayed in a new dialog 
window (see Fig. 2-6).  

6.  Click on [OK] to close the window and continue the installation. 

 
Fig. 2-6: Properties of the BACnet Service 

7. Click in the installation window on [Close] to end the setup (see Fig. 2-7). 

 
Fig. 2-7: End installation 

The installation of the BACnet Configurator and BACnet Service is finished. 
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2.2.1 Manual Installation of the BACnet Service 

 

Note 
Only perform the following steps if the BACnet Service has not already been 
automatically installed.  
If the service has been correctly installed, this will be indicated in the 
properties of the LAN connection (see Fig. 2-8).  
An active firewall, for example, may be one reason for an unsuccessful 
installation. 

 
Fig. 2-8: Display of the installed BACnet Service 

1. Open the network connections, e.g. using System Control > Network 
Connections and select Properties in the context menu of any (!) network 
connection (see Fig. 2-9). 

 
Fig. 2-9: Properties of the LAN connection 

2. If the BACnet Service has not already been automatically installed, mark 
an entry, e.g. "Internet Protocol (TCP/IP)" and click on [Install...]. 
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3. Select "Protocol" as the network component to be installed and click on 
[Add...] (see Fig. 2-10). 

 
Fig. 2-10: Select Network Protocol 

4. In the following window, click on [Have Disk...] to choose the installation 
file for the Service (see Fig. 2-11). 

 
Fig. 2-11: Open installation file 

5. Open the file "bacstac.inf" in the directory "Driver" of the installation 
directory (see Fig. 2-12). 

 
Fig. 2-12: Open installation file 
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6. Confirm the selected file with [OK] (see Fig. 2-13). 

 
Fig. 2-13: Open installation file 

7. Choose "Cimetrics BACstac�" and install it by clicking on [OK] (see 
Fig. 2-14). 

 
Fig. 2-14: Install BACnet Service 

The properties of the installed BACnet Service are displayed in a new dialog 
window. 
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8. Click on [Edit...] to open the configuration of the BACnet Service (see 
Fig. 2-15). 

 
Fig. 2-15: Properties of the BACnet Service 

9. In this dialog, you will configure BACnet access as needed (see Fig. 2-16). 

 
Fig. 2-16: Properties of the BACnet Service 
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10. Close the dialog by clicking [OK] to save changes or by clicking [Cancel] 
to close without saving. 

In the network properties, you will see the successfully inserted BACnet 
Service "Cimetrics BACstac�" (see Fig. 2-17). 

 
Fig. 2-17: Successful insertion of the BACnet Service 

The installation of the BACnet Configurator and BACnet Service is finished. 



18  � Function 
 Manual Installation of the BACnet Service 

  WAGO-I/O-SYSTEM 759 
  WAGO BACnet Configurator 

3 The WAGO BACnet Configurator 
The WAGO BACnet is an independent commissioning, configuration and 
management software. The tasks of the BACnet Configurator include, among 
other things, the logical structuring of the project and BACnet devices within a 
BACnet/IP network, the addressing of the controller, the configuration of the 
client and the server in each individual WAGO BACnet/IP controller as well 
as a value browser for viewing BACnet object properties. 

 
3.1 Function 

The central component of the BACnet Configurator is the database for 
managing BACnet devices. For BACnet/IP controllers from WAGO, all 
configuration information is stored in this database and can therefore be stored 
and restored at any time. The configuration information of a controller 
includes, among other things, the SYM_XML file that contains the program 
variables of the IEC application, and the so-called Override file that contains 
configuration data created by means of the BACnet Configurator. 

BACnet devices and objects are displayed, on the one hand, in a flat, non-
hierarchical network view and, on the other hand, in a structured view that can 
be freely configured by the user (Structured View). The Structured View 
allows the user to organize BACnet devices and objects according to logical 
aspects, such as their location or responsibility within a building. 

Changes can be made online and/or offline, depending on the type of 
configuration data, i.e. with or without a connection between the BACnet/IP 
Controller and the PC on which the BACnet Configurator is installed. If, for 
example, devices in the BACnet/IP network are being sought, IP settings are 
being set or data is being backed up/restored, these changes are done online. 
Changes can be made to configurations of BACnet objects, Client Mappings 
(links between BACnet properties) and BACnet network settings (e.g. for 
BBMD, PTP, etc.) both online and offline. In offline changes, the new data are 
first saved in the database and can be downloaded at a later time into the 
desired devices. 

In summary, the BACnet Configurator queries, monitors and alters current 
values of object properties. Supplemented by a whole series of BACnet 
services, the user can thus act on a BACnet/IP network. 



  Function �  19 
  BACnet Objects 

WAGO-I/O-SYSTEM 759   
WAGO BACnet Configurator  

3.1.1 BACnet Objects 

According to the BACnet Standard, 25 different objects and 38 services are 
supported (Last update: BACnet Standard SSPC 135-2004). An object is 
structured in several object-specific properties. These properties are altered 
using services. 

Objects can be created and configured and the default values of their 
properties can be changed in the BACnet Configurator. Three types of objects 
are differentiated: 

1. BACnet objects defined by the IEC or SYM_XML file (SYM_XML 
objects) 

2. Automatically installed BACnet objects that represent the inputs/outputs of 
the modules connected to the controller (native objects) 

3. BACnet objects created by the BACnet Configurator (override objects) 

Even if the BACnet Configurator recognizes and displays the origin of an 
object (SYM_XML, native, override), it presents all three types of objects in 
the same manner and allows a uniform handling of all types of objects. 

3.1.1.1 Creation of BACnet Objects 

The manual creation of objects or the import of a SYM_XML file (IEC) are 
not absolutely necessary for the controller to run. If the BACnet Configurator 
is started without any additional settings, configurations or imports, the 
controller creates objects that are available through the connected module 
constellation (native objects) in online mode. 

The properties of the automatically created, native BACnet objects of the 
digital and analog inputs and outputs are given default values. The default 
values can be configured in the user interface. For the first boot up of the 
controller, default values saved in the firmware are used in the objects, e.g. 
"111" for the property "Limit_Enable" of the Analog-Input Object. 

Other objects, in addition to the automatically installed objects, can also be 
created. 

Objects that can be created with the BACnet Configurator: 

BACnet Object Description 

ACCUMULATOR Count value entry; counts incoming impulses 

ANALOG_INPUT Analog input; measures voltage or temperature, for instance 

ANALOG_OUTPUT Analog output; is used to position controllers, for instance 

ANALOG_VALUE Analog value; results from a calculation, for instance 

AVERAGING Statistical average and standard deviation; calculates the 
average and standard deviation of a referenced property 
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BACnet Object Description 

BINARY_INPUT Binary input; measures whether a switch is switched on or off, 
for instance 

BINARY_OUTPUT Binary output; alternates between two states 

BINARY_VALUE Binary value; represents one of two possible states 

CALENDAR Calendar; contains data lists for creating days/times/etc. with 
special status (e.g. holidays) 

COMMAND Command; writes a predefined list of properties, one after the 
other 

FILE File; represents a file that can be read and/or written using 
BACnet services 

GROUP Group; used to group property values 

LIFE_SAFETY_POINT Safety point; encapsulates information on the status of a hazard 
report 

LIFE_SAFETY_ZONE Safety zone; summarizes safety points and/or additional safety 
zones 

MULTISTATE_VALUE Multistate value; represents one of several possible states 

NOTIFICATION_CLASS Notification class; assigns alarm and event reports to one or 
more recipients 

PULSE_CONVERTER Impulse converter; converts counted impulses into physical 
units. 

SCHEDULE Schedule; for establishing certain actions at predefined times 

TREND_LOG Trend log; records time- or event-based changes in property 
values 

 

Objects that are not created using BACnet Configurator: 

Object Description 

DEVICE Device; represents the BACnet/IP Controller. There is only one 
device object that is automatically created by the controller. 

LOOP Control loop; represents a closed loop control (either P-, I-, D-, 
PI-, PD- or PID). 

 

 

Note 
The Loop Object is expected to be supported starting with software version 2 of 
the BACnet/IP Controller and the BACnet Configurator. 

 

Note 
A maximum of 1000 objects can be created in the 750-830 BACnet/IP 
Controller. 
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3.1.1.2 BACnet Instance Numbers 

Each BACnet device within a BACnet network must possess a unique 
instance.  

The instance number is the object instance number of the device's Device 
Object and can be read from the Object ID of the Device Object. 

Object ID 

Object Type Object Instance Number 

 
The instance number is generated from the first (lowest value) 22 bits of the 
MAC address of the BACnet/IP controller: 

MAC address of the controller:   00:30:DE:02:11:3F  
22 bits (LSB) of the MAC address  00:30:DE:02:11:3F  

0x2113Fhex = 135487dez  
The instance number of the BACnet/IP controller is 135487 in this case. 

There is still the possibility of reconfiguring instance numbers. Automatic 
generation only affects the standard instance number without configuration. 

 

Note 
By changing the instance number of an object, all persistent property values of the 
respective object will be deleted. From that point, the configured values will be 
used. Persistent property values are those values which you have loaded into the 
controller using the "Commit_Value" function. 

 

Additional Information 
The name of a device that is still unconfigured is determined as follows by the 
controller and displayed in the BACnet Configurator: "Device_[MAC-Address]".
By appending the MAC address along with the instance number, the device name 
can also be uniquely resolved as such in the network. 
Example, "Device_0030de02113f". 
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3.1.2 BACnet Services 

The following table shows which BACnet services are used by the functions 
of the WAGO BACnet Configurator. 

Function BACnet Service(s) 

Searching the network using Scan-Dialog • Who-Is 

• I-Am (received)  

• ReadProperty 

• ReadPropertyMultiple (only if "Scan Objects" is 
set)  

The existence of one or more found or 
fixed, entered devices from the pool Scan 
is tested. 

The search is conducted either manually, 
or automatically if the device is selected in 
the tree, added to the database or opened 
for configuration for the first time. 

• ReadProperty 

• ReadPropertyMultiple 

Automatic device search ("Device Auto 
Discovery") 

• Who-Is 

• I-Am (received) 

• ReadProperty 

Online/offline monitor for devices • Who-Is 

• I-Am (received) 

• ReadProperty 

Monitor for property values • ReadProperty 

Writing of a property value • WriteProperty  

Restart of a device • ReinitializeDevice (cold or warm start)  

Time synchronization • TimeSynchronization  

• UTCTimeSynchronization 

Communication behavior of the device • DeviceCommunicationControl 

Commands to Life-Safety Object • LifeSafetyOperation 

BACnet file transfer • ReadProperty 

• AtomicReadFile (if a file object is being read)  

• AtomicWriteFile (if a file object is being written) 

BACnet backup and restoration • ReadProperty 

• ReinitializeDevice (StartBackup, EndBackup, 
StartRestore, EndRestore, AbortRestore)  

• AtomicReadFile (during a backup) 

• AtomicWriteFile (during a restoration) 
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3.1.3 Configuration Files  

The BACnet Configurator processes different configuration files: 

• The SYM_XML file is created using the software WAGO-I/O-PRO CAA. 
The file contains, among other things, all BACnet-specific variables of the 
IEC application (IEC variables). In order to further process these IEC 
variables, the SYM_XML file is imported into the BACnet Configurator 
(either offline or online by uploading from an already configured device). 
IEC variables and BACnet objects defined by IEC variables can be 
configured and linked with BACnet object properties in the BACnet 
Configurator. An IEC variable can only be linked if it has not already been 
assigned permanently to a property by SYM_XML. 

 
• The Override File contains all configuration information created with the 

BACnet Configurator, for example the previously described assignment of 
IEC variables to object properties, but also default values of properties and 
Client Mappings.  
The name "Override" implies that the configuration information in this file 
has precedence over the standard configuration settings in the controller 
firmware.  
Every Override File is an XML file according to Extensible-Markup-
Language (XML) 1.0, Fourth Edition. Therefore, a large part of this 
description consists of XML element definitions. The Override File can be 
installed, processed and uploaded. 

 
• The WAGO Database XML contains generic BACnet devices and 

WAGO BACnet devices. The SYM_XML file (if available) and the 
Override file (always present) are stored in the database for WAGO 
BACnet devices. All BACnet configuration information is included. Each 
external BACnet device is stored as a summary of its objects, properties 
and property values. The file format corresponds to the format of the 
Override file. 

 
• The file persistent.bin is a configuration data memory for changes in 

runtime. Data that are transmitted ad hoc via "Commit Value" to the 
controller are saved here. The file is used by the Configurator and should 
not be manually altered. 

 
The central configuration files, SYM_XML and Override, for all WAGO 
BACnet/IP controllers found in the database of the BACnet Configurator are 
saved. It is therefore possible to recover a configuration at any time. 
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3.1.4 Persistent and Configured Values 

Values of object properties can be changed in two ways in the BACnet 
Configurator: 

In the configuration area (display of configured values) 
All settings for objects, properties and values are done here. Changes to 
properties of an object are marked with a symbol. The entire configuration is 
loaded into the controller. 

In the runtime environment (display of life values) 
Fast, convenient changing of one or more property values and direct loading 
into the controller. The data will be persistently stored. 

 

Note 
Properties that have been changed in the configuration area and marked as 
changed overwrite the persistent runtime values. Persistent values remain 
when downloading a configuration only if these values have not been 
changed in the configuration area. 

An example of working with persistent and configured values can be found on 
page 94. 

 

3.1.5 EDE Files 

EDE files are used for exchanging BACnet device information between 
different manufacturers. The device information contains objects or default 
values for certain properties contained in the device, for instance. 

EDE files can be created and imported by the BACnet Configurator. These are 
not (device) configuration files since not all information on an object is 
usually listed in an EDE file. 

 

Additional Information 
The definition of the EDE format can be found on the web site 
http://www.big-eu.org/service/software.php . 

 

http://www.big-eu.org/service/software.php
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3.2 The Graphical User Interface 
The graphical user interface of the WAGO BACnet Configurator is described 
in the following. 

 
Fig. 3-1: Graphical User Interface 

Legend: 

①  Menu bar (see section 3.2.1) 

②  Toolbar (see section 3.2.2) 

③  Views (see section 3.2.3) 

 ④  Device Pools (see section 3.2.3.1) 

 ⑤  Structured View (see section 3.2.3.2 ) 

⑥  Configuration area (see section 3.2.4) 
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3.2.1 Menu Bar 

3.2.1.1 File 

The menu item File is used to create, open, save and close projects.  

Menu Item Description 

New Project Create new project 

Open Project... Open existing project 

Save Project Save processed project 

Save Project as... Save processed project as 

Exit End program 

 

3.2.1.2 Edit 

The menu item Edit is used to edit objects in the "Configure" rider. 

Menu Item Description 

Cut Cutting selected objects or object properties 

Copy Copying of selected objects or object properties 

Paste Insertion of selected objects or object properties 

 

3.2.1.3 View 

The menu item View is used to switch between different views.  

Menu Item Description 

BACnet 
Browser 

The BACnet Browser "Browsing & Monitoring" displays the riders "Device 
Pools" and "Structured View" on the left side and the configuration area on 
the right side. The riders "Browsing & Monitoring� and "Device Pools" are 
displayed when starting the BACnet Configurator as standard procedure (see 
Fig. 3-2). 

 
Fig. 3-2: Riders "Browsing & Monitoring" 

 Switching between folder view and list view for objects of a device 

 Sorting of the devices in ascending or descending order in 
alphabetical order, according to online status, device or vendor ID. 

 Closing the Device Pools view  



  The Graphical User Interface �  27 
  Menu Bar 

WAGO-I/O-SYSTEM 759   
WAGO BACnet Configurator  

Menu Item Description 

Structured 
View 

The Structured View represents a logical network construction in a tree 
structure of folders, subfolders and devices. It is opened by clicking on the 
"View" button in the toolbar. 

 
Fig. 3-3: Structured View 

 Closing the Structured View  
Transaction 
Log 

In the rider "Transaction Log", all actions since the start of the software are 
documented with a time stamp (see Fig. 3-4).  

 
Fig. 3-4: Transaction Log 

[Copy to Clipboard] Copying of the content of the Transaction 
Log onto the clipboard 

[Clear Transaction Log] Delete all entries in the Transaction Log  
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3.2.1.4 Pool 

The menu item Pool is used to configure the three Device Pools (Scan, Import, 
Database). Depending on the selected pool, some of the sub-items are enabled 
or disabled. 

Menu Item Description 

Scan... The Scan Dialog is non-modal and also remains open with a click in 
the main window. The dialog is used to search the network for 
BACnet devices. Found devices are displayed in the Scan pool. 

 
Fig. 3-5: Search for BACnet devices 

Instance Number 

└─Device Instance of a particular device 

└─Range Instance number of a range 

└─[Set Min] Lower limit of the instance numbers 

└─[Set Max] Upper limit of the instance numbers 

Network 

└─Global Sending of the request to all accessible 
subnetworks 

└─Local The request is only sent to the subnetwork 
to which the PC is connected 

└─Remote The request is sent to a network number  
1-65534. 

Scan 

└─Scan     
     Objects 

Querying of devices and objects 

└─Incremental 
      Scan 

Adding new devices without discarding 
already scanned devices 

[Scan] Execution of the network search 

[Close] Closing the dialog - has no effect on the 
network search  

Rescan All Devices� Re-scan all devices from the Scan pool 

Device Auto 
Discovery 

Execute automatic device recognition and device search in the 
network immediately 

Monitor All Devices Automatic status query of all devices, if selected 
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Menu Item Description 

Services 

└─Synchronize  
     Time... 

Opening a dialog for time synchronization of the devices 

In this dialog, the time offset in hours and minutes in relation to 
UTC time (Greenwich meridian), which is independent of summer 
(daylight savings) and winter (standard) time, is set. 

 
Fig. 3-6: Synchronize time 

Time 

└─Now System time of the PC 

└─User Freely adjustable time 

└─[Get System UTC 
      Offset] 

Automatic calculation of the time offset 

Date 

└─Today Locally set date 

└─User Date of another user 

Broadcast 

└─Global Sending of the request to all accessible 
subnetworks 

└─Local The request is only sent to the 
subnetwork to which the PC is connected

└─Remote Network number 1-65534 

[Sync Local _ : _ : _ ] Synchronizing of the device time with 
the PC time 

[Sync UTC _  : _ : _ ] Synchronizing of the device time with 
UTC time  

Add 

└─Wago Device Adding of new WAGO BACnet/IP controllers, if the Database pool 
is chosen. 
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Menu Item Description 

Import 

└─EDE... Importing of EDE files 

If EDE files are imported, the devices described in them are taken 
into the Import pool. From there, they can be taken into the 
database. When doing so, a device is first added to the database as a 
generic device because of the incomplete information in the EDE 
files. Generic devices added to the database can be converted to 
WAGO devices. Depending on the pool just selected, the menu 
items are enabled or disabled. 

 
Fig. 3-7: Importing an EDE file 

EDE Files  

└─EDE File Importing of the EDE file "EDE File"; contains 
a list of all objects 

└─EDE State 
     Text File 

Importing of the EDE file "EDE State Text 
File"; contains descriptions of states, e.g."0/1" 
or "on/off" for digital values 

└─Encoding Selection of a character coding for EDE files: 
ISO-8895-1, ASCII or UTF8 

[Import] Importing of the incorporated EDE files 

[Cancel] Closing of the dialog  

└─Override... Importing of an Override file (WAGO device configuration file in 
XML format) 

└─SYM_XML Creation of a WAGO device in the Import Pool based on a 
SYM_XML file 

└─WAGO Database  
      XML... 

Importing of the WAGO database 

Entries in the database can be exported and re-imported as WAGO 
BACnet Database XML. This possibility existed because import and 
export using the EDE format does not include all data. 
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Menu Item Description 

Export 

└─EDE... Exporting as EDE file if devices are present in the database 

 
Fig. 3-8: Exporting an EDE file 

General  

└─Project Name Name of the project 

└─Export Folder Folder in which the EDE files are stored 

└─Encoding ISO-8895-1, ASCII or UTF8 character format

EDE Export  

└─Version of  
      Ref. File 

Version of the project 

└─Author Author of the project 

└─Limited  
      Resources 

Special limitations of the project that must be 
observed 

Export Files  

└─EDE Information on the project, contained objects, 
descriptions, values and references to the State 
Text and Unit file 

└─State-Texts Lists of states from State Text, Inactive Text 
and Active Text Properties of multistate or 
binary objects 
Example: on/off, open/close. Reference 
numbers included refer to the EDE file. 

└─Unit-Texts List of all BACnetEngineering Units and 
proprietary units of a project and the codes 
belonging to each of them 

└─Object-Types List of supported BACnet objects; EDE file 
refers to this file 

 

Additional Information 
See also the definition of the EDE format at 
http://www.big-eu.org/service/software.php  

http://www.big-eu.org/service/software.php
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Menu Item Description 

 [Export] Exporting of EDE file(s) 

[Cancel] Abort settings  

└─WAGO Database  
      XML.. 

Exporting of the WAGO Database to the selected folder 

Remove All Devices... Delete all devices from the selected pool 
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3.2.1.5 Device 

The menu item Device is used to configure devices as well as to backup, 
recover, import and export configuration data.  
Depending on which pool the device is selected from, some of the sub-items 
are enabled or disabled.  

Menu Item Description 

Close Configuration Closing of the configuration for the selected device  
(only in the rider "Configure") 

Download 
Configuration 

Downloading of the configuration 

 
Abb. 3-9: Downloading of the configuration 

Options  

└─Device Mac  
      Address 

Network number followed by 
BACnet MAC address.  
The latter is an approximate IP 
address for BACnet/IP followed by a 
UDP Port Number (usually the 
symbolic value BAC0hex or 
47808dez). For BACnet/MSTP, the 
BACnet MAC address is a number 
within the range 0-255. 

Example: 192.168.1.201-BACO 

└─Reset device after
     download 

Triggering of a restart after 
downloading the configuration 

    └─Password If selected, entry of the password in 
the format CharString, 
ISO_8859_1_String, UCS_2_String 

[Download  
Configuration] 

Load current configuration to the 
controller (only in the rider 
"Browsing & Monitoring") 

[Cancel] Abort/closing of the dialog  
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Menu Item Description 

Configure... Opening of the configuration area for a previously selected device 
(only in the rider "Browsing & Monitoring") 

Add/Store to Database Storing the device in the database ("Add" when first entering the 
device, after that, "Store") 

Rescan selected  
Device(s) 

Rescanning of a device (object list and properties) 

Remove... Removal of a selected device 

Several devices can be removed using multiple selection in the 
pool rider. 

 
Fig. 3-10: Delete device 

Device Monitor Devices are monitored using "Device Monitor" (if set). Switching 
the monitor on and off can also be done in the configuration area 
of the device (see Fig. 3-11). 

 
Fig. 3-11: Monitor devices  

Services 

└─Reset... Restarting of each of the enabled devices and entering of an 
optional password for the Reset command. 

 
Fig. 3-12: Reset Device 

Reset Service 

└─Device Address BACnet MAC address of the device to 
be restarted  
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Menu Item Description 

└─Password If selected, entry of the password in the 
format CharString, ISO_8859_1_String, 
UCS_2_String 

└─Warm/Cold Start Software reset 

[Reset Device] Triggering of a restart 

[Close] Closing of the dialog without a device 
restart  

 

Note 
To reset the password, open the configuration, select the 
device in the tree to the left, choose the rider "IP 
Settings" and enter a new password under "Security". 
The new password is enabled after downloading and 
restarting. 

└─Backup & Restore... Backup 
Creation of a backup copy of the configuration data of a selected 
device: Time stamp for testing new configurations, override, 
SYM_XML, persistent, NOVRAM, EEPROM and CoDeSys data 
(without WebVisu).   

Restore 
Restoration of the configuration data of the device just selected 

 
Fig. 3-13: Backup and restoration 

Folder Selection of the source/target folder, depending 
on whether a backup or restoration is being 
performed 

The remote and local file and the status of the backup/restoration 
appear in the display. 
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Menu Item Description 

 Options 

└─Timeout Timeout (in seconds), which is written in the 
property "Backup_Failure_Timeout" as soon 
as Backup/Restore is executed. If the BACnet 
device receives no command belonging to a 
backup/restore procedure within this timeout, 
the device ends the backup/restore procedure. 

└─Password Password in the format CharString, 
ISO8859_1_String or UCS_2_String 

└─Allow  
     Individual 
     Selection 

Allows the selection of the file objects that 
can be backed up/restored (if checkbox set). 

└─Force Reset Restart of a device after a restoration 

Backup Saving device data 

Restore Restoration of device data 

[Start] Starting Backup or Restore 

              
 Abb. 3-14: Backup files 

Data is stored with a backup according to device 
name. If data is backed up, the Configurator searches 
for this exact name (caution in case of renaming). If 
data is transferred to another device using Restore, 
and "not found" is displayed under "Local File," 
double click on the respective line and select the files 
manually. Pay attention to corresponding types and 
the order of the files when doing this. 

[Cancel] Closing of the dialog without changes  
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Menu Item Description 

└─Communication... Opening of a dialog for configuration of BACnet services for the 
selected device 

 
Fig. 3-15: Service settings 

Settings 

└─Communication "Enable" (enabling of services), 
"Disable" (disabling of all services 
except for "Restart Device" and the 
communication service itself) and 
"Disable Initiation" (disabling of 
initialization)  

 

Note 
Only those services that are used in the BACnet 
Configurator are affected by the settings. No other 
services supported by the controller are altered. 

└─Password Entering of a password in the format 
CharString, ISO_8859_1_String or 
UCS_2_String (if checkbox set) 

└─Time Duration 

 

Entering of the time, in minutes, for the 
disabling of services (only available if 
"Communication > Disable") is chosen  

[Send] Updating of the service settings 

[Close] Discarding of changes since the last 
backup; closing of the dialog  
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Menu Item Description 

└─Synchronize Time... Opening a dialog for time synchronization of the devices 

In this dialog, the time offset in hours and minutes in relation to 
UTC time (Greenwich meridian), which is independent of summer 
(daylight savings) and winter (standard) time, is set. 

 
Fig. 3-16: Synchronize time 

Time  

└─Now System time of the PC 

└─User Freely adjustable time 

└─ [Get System UTC  
       Offset] 

Automatic calculation of the time 
offset 

Date  

└─Today Locally set date 

└─User Date of another user 

Broadcast  

└─Global Sending of the request to all 
accessible subnetworks 

└─Local The request is only sent to the 
subnetwork to which the PC is 
connected 

└─Remote Network number 1-65534 

[Sync Local _ : _ : _ ] Synchronizing of the device time 
with the PC time 

[Sync UTC _ : _ : _ ] Synchronization of the device time 
with UTC time  
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Menu Item Description 

└─Life Safety   
      Operation 

The following dialog is displayed if a Life Safety Object has been 
added to a device and this was selected in the Device Pools with 
the mouse. The LifeSafetyOperation Service, along with other 
read/write services, takes a special position and can therefore be 
specially configured. 

 
Fig. 3-17: Life Safety Operation 

Settings 

└─Operation Settings of the alarm type: Silence, Silence 
Audible, Silence Visual, Reset, Reset Alarm, 
Reset Fault, Unsilence, Unsilence Audible, 
Unsilence Visible 

└─Process ID Entering of any chosen number in order to limit 
the response to this query by responses to other 
queries. 

└─Source Character string for the description of the user 
who is triggering the service 

└─Source  
      Encoding 

Format for the entry "Source"; CharString, 
ISO8859_1_String or UCS_2_String 

[Send] Generation of a LifeSafetyOperation service,  
e.g. to switch off alarms 

[Close] Closing of the dialog  

Import  

└─Upload SymXML from Device... Load SYM_XML file from the device 

└─SymXML from File... Opening of a SYM_XML file 

└─Remove SymXML Deletion of a SYM_XML file 

└─Upload Override from Device� Load the Override file from the device 

└─Load Override from File... Opening of an Override file 

└─Remove Override Deletion of the Override file 

Export 

└─EDE... Exporting of the EDE file; as soon as devices are 
available in the database, they can be exported as 
EDE files. 

└─SYM_XML... Export SYM_XML file 

└─Override... Export Override file 

└─WAGO Database XML Export WAGO database 
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3.2.1.6 Extras 

The menu item Extras contains general setting possibilities in the BACnet 
Configurator.  

Menu Item Description 

Options... Opening of a new dialog for supplementary settings: 

 
Fig. 3-18: Supplementary settings 

General  

└─[Choose...] Choosing of a color to mark a selected device 
within different pools 

└─Minutes The "Device autodiscovery scan time" refers to 
the function "Device Auto Discovery" (see 
section 3.2.2). It indicates the time interval, in 
minutes, for the automatic search of the network 
for new devices. 

└─Enable Auto Device Discovery on Start 

 Choose this option to search for devices with 
every software start of the network. 

└─Scan Devices when they come online 

 Devices and their configuration may have 
changed while offline. If this option is selected, 
devices that go from the offline to the online state 
will be rescanned. 

[Save] Backup of settings 

[Cancel] Abort/closing of the dialog  
 

3.2.1.7 Help 

The menu item Help contains information on the BACnet Configurator itself.  

Menu Item Description 

About Display of the version and copyright information 
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3.2.2 Toolbar  

Symbol Function Description 

 New Project Creation of a new project 

 Open Project Opening of a window to select a project file 

 Save Saving of a project 

 Cut Cutting selected objects or object properties 

 Copy Copying of selected objects or object properties 

 Paste Insertion of selected objects or object properties 

 
BACnet Scan Searching the network for BACnet devices and listing of 

these devices in the Scan pool 

 
Rescan Devices Search object and property lists of the devices in the Scan 

pool again 

 
Reset Restart of the selected device 

 
Backup &  
Restore 

 

Backup 
Creation of a backup copy of all configuration data of a 
selected device: Time stamp for testing new 
configurations, override, SYM_XML, persistent, 
NOVRAM, EEPROM and CoDeSys data (without 
WebVisu).  

Restore 
Restoration of the configuration data of the device just 
selected 

 
Fig. 3-19: Backup and restoration 

Folder Selection of the source/target folder, 
depending on whether a backup or 
restoration is being performed 

The remote and local file and the status of the 
backup/restoration appear in the display. 
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Symbol Function Description 

  Options 

└─Timeout Timeout (in seconds), which is 
written in the property "Backup_ 
Failure_Timeout" as soon as 
backup/restore is executed. If the 
BACnet device receives no 
command belonging to a backup/ 
restore procedure within this 
timeout, the device ends the 
backup/restore procedure. 

└─Password Password in the format CharString, 
ISO8859_1_String or UCS_2_String

└─Allow  
     Individual 
     Selection 

Allows the selection of the file 
objects that can be backed 
up/restored (if checkbox set). 

└─Force Reset Restart of a device after a restoration

Backup Saving device data 

Restore Restoration of device data 

[Start] Starting Backup or Restore 

 Abb. 3-20: Backup files 

Data is stored with a backup according to 
device name. If data is backed up, the 
configurator searches for this exact name 
(caution in case of renaming). If data is 
transferred to another device using Restore, 
and "not found" is displayed under "Local 
File," double click on the respective line 
and select the files manually. Pay attention 
to corresponding types and the order of the 
files when doing this. 

[Cancel] Closing of the dialog without changes  
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Symbol Function Description 

 
Communication... Opening of the dialog "Communication Service" for the 

selected device. 

 
Fig. 3-21: Communication Service 

Setting 

└─Communication "Enable" (enabling of services),
"Disable" (disabling of all 
services except for "Restart 
Device" and the communication 
service itself) and "Disable 
Initiation" (disabling of 
initialization)  

 

Note 
Only those services that are used in the 
BACnet Configurator are affected by the 
settings. No other services supported by 
the controller are altered. 

└─Password Entering of a password in the 
format CharString, 
ISO_8859_1_String or 
UCS_2_String (if checkbox set) 

[Send] Updating of the service settings 

[Close] Discarding of changes since the 
last backup; closing of the dialog 
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Symbol Function Description 

 
Life Safety  
Operation... 

The following dialog is displayed if a Life Safety Object 
has been added to a device and this was selected in the 
Device Pools with the mouse. The LifeSafetyOperation 
Service, along with other read/write services, takes a 
special position and can therefore be specially configured. 

 
Fig. 3-22: Life Safety Operation 

Settings  

└─Operation Setting of the alarm types: Silence, 
Silence Audible, Silence Visual, 
Reset, Reset Alarm, Reset Fault, 
Unsilence, Unsilence Audible, 
Unsilence Visible 

└─Process ID Any chosen number for limiting the 
response to this query by responses to 
other queries. 

└─Source Character string for the description of 
the user who is triggering the service 

└─Source  
     Encoding 

Format for the entry "Source"; 
CharString, ISO8859_1_String or 
UCS_2_String 

[Send] Take over settings for the Life-Safety 
Object 

[Close] Closing of the dialog  
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Symbol Function Description 

 
Synchronize  
Time 

Opening a dialog for time synchronization of the devices. 
In this dialog, the time offset in hours and minutes in 
relation to UTC time (Greenwich meridian), which is 
independent of summer (daylight savings) and winter 
(standard) time, is set. 

 
Fig. 3-23: Synchronize time 

Time  

└─Now System time of the PC 

└─User Freely adjustable time 

└─[Get System UTC 
     Offset] 

Automatic calculation of the 
time offset 

Date  

└─Today Locally set date 

└─User Date of another user 

Broadcast  

└─Global Sending of the request to all 
accessible subnetworks 

└─Local The request is only sent to the 
subnetwork to which the PC is 
connected 

└─Remote Network number 1-65534 

[Sync Local _ : _ : _ ] Synchronizing of the device 
time with the PC time 

[Sync UTC _ : _ : _ ] Synchronization of the device 
time with UTC time  
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Symbol Function Description 

 View Choose between the views "Device Pools" and/or 
"Structured View" 

 
Download 
Configuration 

Load current configuration to the controller  
(only in the rider "Browsing & Monitoring") 

 
Abb. 3-24: Downloading of the configuration 

Options  

└─Device Mac  
      Address 

Network number followed by 
BACnet MAC address.  
The latter is an approximate IP 
address for BACnet/IP followed 
by a UDP Port Number (usually 
the symbolic value BAC0hex or 
47808dez). For BACnet/MSTP, 
the BACnet MAC address is a 
number within the range 0-255. 

Example: 192.168.1.201-BACO 

└─Reset device 
     after download 

Triggering of a restart after 
downloading the configuration 

    └─Password If selected, entry of the password 
in the format CharString, 
ISO_8859_1_String, 
UCS_2_String 

[Download  
Configuration] 

Load current configuration to the 
controller (only in the rider 
"Browsing & Monitoring") 

[Cancel] Abort/closing of the dialog  

 Device Auto  
Discovery 

Switching on and off of the automatic device recognition 

If automatic device recognition is enabled, new devices 
are searched for in a cyclical manner. Found devices are 
added to the Scan pool. The cycle time for the search is 
determined under "Extras" > "Options" (only available in 
the rider "Browsing & Monitoring") 

 

Life Monitor Enabling and disabling of the Life-Monitor 

If Life-Monitor is enabled for properties, current property 
values of devices are read and displayed. The Life-
Monitor for devices monitors whether a device is online 
or offline (only available in the rider "Browsing & 
Monitoring") 

 
 



  The Graphical User Interface �  47 
  Toolbar 

WAGO-I/O-SYSTEM 759   
WAGO BACnet Configurator  

If "Transaction Log" is enabled, the following buttons are also displayed: 

Symbol Function Description 

 Copy to Clipboard Copying of the Transaction-Log onto the 
clipboard 

Clear Transaction Log Deletion of all entries in the Transaction 
Log 

 
If the rider "Configure" is opened, the following buttons are also displayed: 

Symbol Function Description 

 IEC Mappings Opening of the non-modal "IEC Mapping 
Editors" (see section 3.2.4.3.2) 

 Client Mappings Opening of the non-modal "Client Mapping 
Editors" (see section 3.2.4.3.1) 
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3.2.3 Views 

The two views "Device Pools" and "Structured View" on the left side display 
the devices, objects and logical structuring of the BACnet/IP network (see Fig. 
3-25).  

 
Fig. 3-25: Views 

If only the "Device Pools" are displayed, select "Structured View" as well in 
the main menu or in the toolbar under "View" (see Fig. 3-26). 

 
Fig. 3-26: Changing the view via the toolbar 

The two views "Device Pools" and "Structured View" are explained in the 
following sections. 
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3.2.3.1 Device Pools 

The Device Pools view displays the devices known to the BACnet 
Configurator in three different pools as a tree diagram (see Fig. 3-27). 

  
Fig. 3-27: Device Pools 

The Device Pools are the central contact point for the use of the BACnet 
Configurator. Each pool fulfills a special task: 

Database Pool  
The Database pool is the core piece of the BACnet Configurator. It represents 
all configurations and devices that are locally stored. This pool is persistent - 
the data it contains therefore remain, even after backup and subsequent ending 
of the program. All other pools, on the other hand, are transitory; their content 
is lost when the program is ended.  
For WAGO devices, changes or expansions of the configuration can be done 
offline and downloaded into the device. In devices from other manufacturers, 
no offline change is provided for; here, only a "snapshot", i.e. a momentary 
view of the device, is stored in the database.  
Instance and device numbers of the devices in the Database pool must be 
unique. This is the prerequisite for a unique identification of the devices in 
BACnet networks (Identification). 

Import Pool  
The Import pool is used to import devices via EDE or WAGO database files. 
This pool, in contrast to the Scan and Database pools, has no limitation with 
regard to the uniqueness of the device instance numbers. No consistency tests 
are done since the Import pool is primarily intended for viewing device data. 
Imported devices are taken into the Database pool for further processing. 

Scan Pool 
Displays all devices that have been identified during a search of the network 
or by the automatic recognition of "Device Auto Discovery".  

Regardless of which pool a device or object is selected from, detailed 
information is displayed on the right side in the configuration area (see section 
3.2.4). 
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3.2.3.2 Structured View 

The Structured View represents the logical network construction in a tree 
structure of folders, subfolders and devices.  

New folders are added by right clicking on an existing entry and selecting 
Add Folder in the context menu (see Fig. 3-28). The new folder is created 
beneath the selected entry. 

 
Fig. 3-28: Adding folders to the Structured View 

The structure of the folders represents the typical construction of a building 
project (see Fig. 3-29). For instance, real estate, buildings, levels, and rooms 
all the way down to the devices can be mapped. The number of levels that can 
be used is unlimited. 

 
Fig. 3-29: Structured View Register 

Devices can be selected from the Database pool and moved to the Structured 
View by holding the mouse button down (see Fig. 3-30). In this way, devices 
are logically assigned, e.g. certain controllers for a work area. The device is 
not deleted from the Database pool by arranging it in the Structured View.   

 
Fig. 3-30: Incorporating objects in the Structured View 
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In the configuration area, you can change the name of the selected element and 
assign a type and a description (see Fig. 3-31).  

 
Fig. 3-31: Structured View Register 

Pool Description 

Name Name of the selected element in the Structured View 

Type Type of element (e.g. network, system, device, data point) 

Description Description of the element 

Object/Folder Name Name of the groups/elements in which the element is found 

Type Type of groups/elements in which the element is found 

 
Different objects of different devices can be logically assigned. This 
assignment can be done multiple times in order to assign objects to different 
logical categories, if applicable. The Structured View is saved and loaded 
together with the project. 

 

Additional Information 
You can add devices or device objects from the Database pool to the 
Structured View. When you do this, the device object is treated like the 
device itself, i.e. adding the device object to the Structured View has the 
same effect as adding the device. 
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3.2.4  Configuration Area 

In the configuration area, on the right side of the window, all configuration 
settings for WAGO BACnet/IP controllers can be undertaken (creation of 
objects, Client Mappings, etc.). The content of this area is dependent on 
whether the rider "Browsing & Monitoring" or "Configure" is opened. The 
rider "Browsing & Monitoring" is open by default, while the rider "Configure" 
is opened by right clicking on a device in the device pool. 

In the view "Browsing & Monitoring", the function of the right side of the 
area depends on which pool the just enabled device is selected from: 

• In the Import pool, values can be viewed but not changed. The values are 
also not changed when Life-Monitor is enabled. 

• In the Scan and Database pools, whether the monitoring of properties is 
enabled or not must be identified. 
• disabled � values that were current at the time of adding/updating are 

displayed. The device concerned is indicated with a gray dot. 
• enabled � current property values are displayed 

The device concerned is indicated with a green dot. 
 
In the rider Configure, on the right side of the window, the configurations of 
the pools, devices and objects that you select in Device Pool or in the 
Structured View are displayed. If lists are displayed in the configuration area, 
you can go to the next deeper level by double clicking on an element of this 
list: 

Example: 
With a click on the Scan pool, the details of this pool and a list of the devices 
it contains are displayed on the right side. A double click on a device in the list 
then opens the device details with a list of the objects it contains. A double 
click on one of the objects opens the object configuration with a list of the 
object properties it contains. 

 

Additional Information 
In the rider "Configure", you can select several objects on the left in the tree. 
On the right, then, only the properties that are common to all the objects are 
still displayed. This then forms an "average" of all properties of the selected 
objects, and the property values can be easily set/altered for several objects. 

In the following, the configuration area in the rider "Browsing & Monitoring" 
is described in relation to the selection of different pools, devices and objects 
(see section 3.2.4.1 through 3.2.4.3). Inside the description of the devices, the 
rider "Configure" can be opened with other riders 

(BBMD, IP settings, IEC variables - see sections 3.2.4.2.1 through 3.2.4.2.4). 
In the rider "Configure", additional information for the pools, devices and 
objects is sometimes displayed over against the rider "Browsing & 
Monitoring". 
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3.2.4.1 Pool 

By default, three Device Pools are displayed: "Scan", "Import" and 
"Database". The numbers in the brackets behind the respective pool indicate 
the number of devices contained. 

With a right click on a pool, a context menu for additional settings will open 
(see Fig.3-32). These correspond to the points in the main menu "Pool" (see 
section 3.2.1.4). Also, all files can be expanded/collapsed in by clicking on 
Expand/Collapse All. 

 
Fig.3-32: Pool context menu 

When selecting a pool from the Device Pools, the configuration area for this 
pool opens on the right side (see Fig.3-33). 

 
Fig.3-33: Configuration area of the pool 

Menu Item Description 

Name Display of the pool name: "Scan", "Import" or "Database" 

List of devices contained 

└─InstNr Instance number of the device 

└─Device Name Name of the devices within the pool 

└─VendorId Manufacturer ID of the respective device 

└─#Objs Number of objects in a device 

└─In Database Indicates whether the device is present in the database 

└─BACnet MAC Network number followed by BACnet MAC address. The latter is 
an approximate IP address for BACnet/IP followed by a UDP Port 
Number (usually the symbolic value BAC0hex or 47808dez). For 
BACnet/MSTP, the BACnet MAC address is a number within the 
range 0-255. Example: 192.168.1.20-BACO 
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Click with the right mouse button on a device in the list and a context menu 
will open that contains the points from the main menu "Device" (see section 
3.2.1.5).  

 
Fig.3-34: Context menu of the device 
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3.2.4.2 Device 

One level below the pools, the devices are displayed.  
The number in the brackets behind the respective device is the instance 
number of the device. 

When a device in the pools Scan, Import or Database is selected, a rider with 
additional details opens on the right side. 

The name, instance number, MAC address and description of the device as 
well as an overview of the objects it contains are displayed (see Fig. 3-35). 

 
Fig. 3-35: Configuration area of the device 

Menu Item Description 

Name Name of the device 

Instance Nr Instance number of the device object by which the device is 
represented 

Online Address Network number followed by BACnet MAC address.  
The latter is an approximate IP address for BACnet/IP followed 
by a UDP Port Number (usually the symbolic value BAC0hex or 
47808dez). For BACnet/MSTP, the BACnet MAC address is a 
number within the range 0-255. 

Configure... Opening of the device configuration (see section 3.2.4.2.1) 

 Monitor Enabled monitoring when the checkbox is checked; otherwise, 
disabled 

Description Description of the device 

Device Link Clickable link that exists whenever a configuration is opened for 
the device.  
Clicking on the link causes a change over to the configuration. 

List of objects contained 

└─Object Name Name of the object, which can be freely chosen 

└─Present Value Current value of the object 
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Menu Item Description 

└─Unit The physical unit of the value of the Present_Value property of 
the analog object (value of the "Units" property) 

└─Type Type of object, e.g. Device, Schedule, Analog Input 

└─InstNr Instance number of the object assigned in the native operation of 
the system, which can otherwise be freely chosen 
Together with the object type, it identifies an object uniquely; in 
the case of the Device Object, the device is also uniquely 
identified. 

 

Note 
By changing the instance number of an object, all 
persistent property values of the respective object 
will be deleted. From that point, the configured 
values will be used.  
Persistent property values are those values which 
you have loaded into the controller using the 
"Commit_Value" function.  

└─#Props Number of object properties 

└─Source Generic, native or SYM_XML-defined object 

 
By clicking on the button [Configure], the rider "Configure" for the selected 
device opens. This rider is also opened if Configure is chosen in the context 
menu of the device. 

Inside the "Configure" rider, on the right side, four additional riders are 
displayed that are described in more detail in the following sections: 

• Device (see section 3.2.4.2.1) 
• BBMD (see section 3.2.4.2.2) 
• IP Settings (see section 3.2.4.2.3) 
• IEC Variables (see section 3.2.4.2.4) 
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3.2.4.2.1 Configuration of "Device" 

In the rider "Device", the device to be configured is displayed on the left and 
the device information on the right (see Fig. 3-36).  

In contrast to the view of the device in the rider "Browsing & Monitoring" 
(see Fig. 3-35), additional information on the configuration and an import 
opportunity for the Override and SYM_XML files are displayed. 

 
Fig. 3-36: Configuration of "Device", "Configure" view 

Menu Item Description 

Name Name of the device 

Instance Nr Instance number of the device object by which the device is 
represented 

Online Address Network number followed by BACnet MAC address.  
The latter is an approximate IP address for BACnet/IP followed by a 
UDP Port Number (usually the symbolic value BAC0hex or 47808dez). 
For BACnet/MSTP, the BACnet MAC address is a number within the 
range 0-255. Example: 192.168.1.20-BACO 

Description Description of the device 

Device Link Clickable link which, when clicked, refers either to the database entry 
(if present) or the Scan entry of the device, depending on where the 
device is located. 
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Menu Item Description 

Configuration Info 

└─Version Version of the configuration 

└─Author Author 

└─Comments Comment 

└─Creation Date Creation date in the format 01.07.2007 00:00:00 

└─Creation UTC  
      Date 

UTC creation date in the format 01.07.2007 00:00:00 

└─Creation Tool Creation tool 

└─Device Type Device type (model identification "750-830"); is filed in the Device 
Object in a similar manner as for the property "Model_Name". 

└─Format Version Format version of the Override file 

Override File [Import...] Opening of a file browser for selecting an 
Override file 

[Upload from Device] Loading of an Override file from the device 

[Remove] Deletion of the Override file being used  
SYM_XML [Import...] Opening of a file browser to select a 

SYM_XML file 

[Upload from Device] Loading of a SYM_XML file from the 
device 

[Remove] Deletion of the SYM_XML file being used  
List of objects contained 

└─Object Name Name of the object, which can be freely chosen 

└─Present Value Current value of the object 

└─Unit The physical unit of the value of the Present_Value property of the 
analog object (value of the "Units" property) 

└─Type Type of object, e.g. Device, Schedule, Analog Input 

└─InstNr Instance number of the object; assigned in the native operation of the 
system, which can otherwise be freely chosen; together with the object 
type, it identifies an object uniquely; in the case of the Device Object, 
the device is also uniquely identified. 

└─#Props Number of object properties 

└─Source Generic, native or SYM_XML-defined object 

└─Create This flag indicates whether the object has been created or not. It is 
primarily intended to prevent the creation of native objects. By default, 
all objects are created. 

└─SubCOV This flag indicates whether the object accepts COV subscriptions for 
the Present_Value (by default and recommendation "Yes"). 

└─SubCOVProp This flag indicates whether the object accepts COV subscriptions for 
any properties of an object (by default, yes). Recommendation: if there 
is a lack of resources in the controller, set this flag to "No". 

└─Intr This flag indicates whether the object supports alarming (Intrinsic 
Reporting). 
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By right clicking on the device, you will obtain a context menu with the 
possibility of adding objects via Add Object (see Fig. 3-37), or to delete them 
via Delete Object(s).  

 
Fig. 3-37: Object context menu 

As soon as you have selected the device with the mouse, a new register, 
"Object: <Object name>" for object configuration is displayed (see Section 
3.2.4.3).  
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3.2.4.2.2 Configuration of "BBMD" 

In the rider "BBMD", the BACnet Broadcast Management Device is 
parameterized. A BBMD enables the sending of BACnet Broadcast Reports 
over IP routers to other networks. Each of the networks to which the 
broadcasts are forwarded and from which broadcasts are received must also 
have a BBMD. 

BBMDs also forward broadcasts to external devices, so-called Foreign 
Devices (FD). FDs are BACnet devices external to the network that report 
directly to a BBMD in order to receive broadcasts (see Fig. 3-38). 

IP

router

IP

router
Internet

BBMD/FD

BACnet

BACnet

BACnet

device

device

device

BBMD/FD

BACnet device

BACnet

BACnet

device

device

Network 1 Network 2

Foreign device

1.Registration

2.Unicast to BBMD/FD

3.Transforming/sending as broadcast  
Fig. 3-38: Broadcast via BBMD 

You can permit the logging on of FDs to a controller by selecting  
Allow Foreign Devices or block foreign devices by disabling the checkbox. 
 
Each BBMD has a Broadcast Distribution Table (BDT) containing the 
BACnet MAC addresses of BBMDs to which the broadcasts are forwarded. 
You can edit the BDT (see Fig. 3-39). 

 

Note 
For correct operation of the BBMD in IP subnets, be sure to enter your own 
device (broadcast mask 255.255.255.255) into the Broadcast Distribution 
Table (BDT). Therefore, a BDT with active BBMD always contains at least 
two entries: the own BBMD with an own IP address and the BBMD of the 
other network. 

BBMD functions that are only related to external devices (on the local IP net) 
are also available without entering the own device. 
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Fig. 3-39: Configuration of "BBMD" 

The following points can be adjusted if Serve as BACnet/IP Broadcast 
Management Device is selected. 

Menu Item Description 

Serve as BACnet/IP 
Broadcast 
Management Device 

Enables/disables BBMD functionality. Prerequisite for all 
settings in this rider. 

Allow Foreign 
Devices 

Choose whenever foreign devices are to be allowed in the 
network to communicate with the selected device 

List of BBMDs 

Address BACnet MAC address of a BBMD (IP address + UPD Port 
Number) 

If directed broadcasts are used, "Mask" designates the 
subnet mask of the network to which the broadcast is sent. 
Otherwise, 255.255.255.255 is used. In this case, a 
broadcast request is sent to the BBMD from which the 
sending of the actual broadcast then takes place. 

If "directed broadcasts" (one hop forwarding) are used, 
"mask" designates the broadcast mask to be used. 
If unicasts are used (two-hop forwarding), broadcast mask 
255.255.255.255 must be entered. In this case, a broadcast 
request is sent by the device via unicast to the BBMD from 
which the sending of the actual broadcast then takes place. 

Mask 

 

Note 
"Directed broadcasts" are usually not possible 
since these are often blocked by IP routers. It is 
therefore recommended that you use two-hop 
forwarding and set broadcast mask 
255.255.255.255. 
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Menu Item Description 

[Add...] Adding a BBMD (see Fig. 3-40) 

 
Fig. 3-40: Adding a BBMD 

Address Entering the IP address (necessary) 

Mask Entering the net mask (optional) 

[OK] Incorporation of the BBMD in the BDT 

[Cancel] Abort/closing of the dialog  
[Edit] Alteration of certain entries.  

[Remove] Deletion of the BBMD 
Selection of several entries by holding down the shift key. 

 
[Add], [Edit] and [Remove] can also be reached through the context menu. 
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3.2.4.2.3 Configuration of "IP Settings"  

In this rider, system-specific settings for IP and security settings are 
undertaken. The controller first runs with standard settings that can be called 
up in the web-based management system of the controller. Changes to IP 
settings in the BACnet Configurator are enabled as soon as [Store and 
Download] is clicked and the BACnet device is restarted. 

 
Fig. 3-41: Configuration of "IP Settings" 

Menu Item Description 

IP Settings 

└─Mode DHCP or static; If no value is set, the controller runs with the 
parameters set in the firmware. 

└─IP Address IP address of the device 

└─Subnet Mask Subnet mask of the device 

└─Gateway Address Gateway address of the device 

└─Primary DNS First Domain Name System 

└─Secondary DNS Second Domain Name System 

Security 

└─Password Password for changing the configuration 
All access restrictions in the BACnet Configurator use the 
same password. By default, no password is set. 

[Set Password...] Opening of a dialog for assigning a 
password (see Fig. 3-42 ) 

 
Fig. 3-42: Setting a password 
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Menu Item Description 

 Password Entering a password 

Repeat Repeating the password 

[Save] Saving the password 

[Cancel] Cancellation of the password assignment  
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3.2.4.2.4 Configuration of "IEC Variables"  

In this rider, the BACnet Configurator lists all IEC variables known from a 
SYM_XML file (see Fig. 3-43).  

A SYM_XML file is created using the software WAGO-I/O-PRO CAA. 

1.  In the WAGO-I/O-PRO CAA software under Project\Options select the 
category Symbol Configuration. 

2.  Place a check mark in the control field Generate XML symbol table. 

3.  Click on the button [Configure symbol file...]. 

4.  Place a check mark in the check box Issue object variables. 

Once these options have been activated, an SYM_XML file will be generated 
automatically with project variables when a project is compiled. 

 

Note 
If the WAGO-I/O-PRO CAA software is in simulation mode, no SYM_XML 
file can be created. 

The created SYM_XML file is imported in the BACnet Configurator along 
with the IEC variables. Here, two types of variables are differentiated. 

1.  IEC variables that are permanently linked with a property of a BACnet 
object as per SYM_XML: These variables cannot be linked to anything 
else. 

2. IEC variables that are not assigned to any object property by the 
SYM_XML: These variables can be assigned to properties in objects with 
the BACnet Configurator. In this case, an IEC variable can be mapped 
directly onto a BACnet property. 
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Fig. 3-43: Configuration of "IEC Variables"  

 
Menu Item Description 

IEC Variable Name Name of the IEC variable 

Data Type Data type of the IEC variable 

Mappable IEC variable can be linked with BACnet property - Yes/No 

Mapped to Property BACnet property is linked with the one IEC variable 

Client Mappings BACnet property is linked with the one other BACnet property 

Access Access mode 

RefID 

Offset 

Values from the SYM_XML file;  
Location of the 61131-variables in the firmware 

Hide fixed mapped 
variables 

Masking/unmasking of fixed mapped, no longer linkable variables 
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Menu Item Description 

[Edit Client  
Mapping...] 

Opening of a non-modal dialog through which BACnet properties can 
be assigned to other BACnet properties.  
Those properties on which the already active IEC variable can be 
mapped or on which it is mapped are displayed. 

 
Fig. 3-44: Client Mapping Editor 

The description of this dialog can be found in section 3.2.4.3.1,  
"Client Mappings". 

 
The Client Mapping Editor can also be reached through the context menu. 
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3.2.4.2.5 Storing and Downloading a Valid Configuration  

The configuration area at bottom left indicates if the configuration you want to 
store is valid. 

   
Fig. 3-45: Warnings are present (left), configuration is valid (right) 

If warnings are present, click on the [ _ Warnings...] button to display the 
warnings (see Fig. 3-46). 

 
Fig. 3-46: Displaying warnings 

If you want to accept the relevant changes despite warning, place a check 
mark in the checkbox prior to warning. Remove the check mark if you don't 
want to make the relevant change. In this case, the property is reset to a valid 
value. 

Menu Item Description 

[Apply Changes] Accept the changes (if checkbox set) or  
reset the change (if checkbox not set) 

[Close] Closing the dialog 

 
At bottom right in the configuration area the buttons [Store and Download] 
and [Store] are shown (see Fig. 3-47). 

 
Fig. 3-47: Storing and downloading settings 

Menu Item Description 

[Store and Download] Accepting the changes; adding the configuration of the device(s) to 
the database if not yet present in the database; downloading the new 
configuration to the device 

[Store] Accepting changes; adding the configuration of the device(s) to the 
database if not yet present in the database 

 
The buttons [ _ Warnings...], [Configuration Valid], [Store and Download] 
and [Store] refer to the entire configuration, i.e. to all settings in the rider 
"Device", "BBMD", "IP Settings" and "IEC Variables". 
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3.2.4.3 Object  

Following the description of the pool and device configuration, this section 
describes the configuration area for objects. 

Objects are arranged in the "Device Pools" one level below the devices and are 
managed in their own folders depending on the type of object (for example, an 
Analog Input Object in the "Inputs" folder). The number in the brackets 
behind the respective object is the instance number of the object. 

By right clicking on an object in both Scan pool and Rescan Object(s), the 
selected object is imported again. Several objects can be selected and scanned 
by holding the control key down.  

 
Fig. 3-48: Scanning again one or several objects in Scan pool 

If you click on an object in the Device Pool, a new "Object<Object Name>" 
register with a list of all associated object properties opens in the configuration 
area to the right. The following symbols are displayed before the property 
names and values.  

The property required for the respective object by the BACnet Standard 

Optional object properties 

 Optional sub-element of a property is activated (can be changed by clicking on symbol)  

 Optional sub-element is activated (can be changed by clicking on symbol)  

Enabled monitoring 

Fig. 3-49: Symbols for required/optional properties and monitoring 

The configuration area of the graphic interface varies, depending on the rider 
selection of "Configure" or "Browsing & Monitoring" (cf. Fig. 3-50 and Fig. 
3-51). 
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Fig. 3-50: Configuration of "Object", view in the rider "Browsing & Monitoring"  

Object view in the rider "Browsing & Monitoring": 

Menu Item Description 

Name Name of the object 

Type Type of the object 

Instance Nr Instance number of the object 

HW Inst Nr The hardware instance number indicates the sequence of 
input/output channels for analog and digital input/output 
objects (display for input/output objects in both "Browsing & 
Monitoring" rider's database pool and "Configure" rider) 

Source Type of the object (native, SYM_XML, Override, generic) 

Show Values 

└─Monitored Values Display of current values 

└─Edited Values Display of altered values 

└─Database Values Display of values that are saved in the database (Display in 
database pool, rider "Browsing & Monitoring") 

[Commit Values] Transmission of altered values to the controller 

Changed properties are highlighted in color: 

green Property has been successfully changed and 
transmitted 

yellow Changed property has not been transmitted yet 
(monitor mode) 

orange Changed property has not been transmitted yet 
(editing mode) 

red Change has failed 

blue Present_Value  
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Menu Item Description 

 Note 
With the "Commit Values" function, you can 
change the BACnet object property values quickly 
and load them into the controller without 
configuration during runtime. The values will be 
persistently stored in the flash memory and 
overwrite existing configuration values. 

Requirements for value changes using "Commit 
Values": Access to the object property is permitted 
(identified by the symbol  in the "Configure" 
rider) 

You can delete persistent values again in three 
different ways: 

1.  Delete the object containing the persistent data 
and load your configuration into the controller 
without this object. Then create a new object with 
standard values. 

2.  Change the object instance number and load 
your configuration into the controller. From that 
point, all property values of this object are assumed 
from your configuration ("Configure" rider). 

3.  Change the specific object property values in the 
"Configure" rider and download the configuration 
into the controller. From that point, these values 
(identified by the symbol  in the "Configure" 
rider) will be taken over from your configuration. 

[Clear] Cancels changes and deletes colored markings 

List of object properties 

└─Name Name of the property 

└─Value Value of the property 

└─Type BACnet data type of the property 

└─Opt There are required and optional fields for structured data 
types. An icon in this column indicates whether the optional 
field is available. By clicking on the icon, you can alternate 
between the states "Field is available" and "Field is not 
available". 

└─Priority Display of the write priority 

└─Status Display of the transmission status 

 
When selecting Configure in the context menu of a device, the rider 
"Configure:<Device Name>" opens. If you click on a device in the tree, the 
configuration area containing additional options (cf. Fig. 3-50 with Fig. 3-51) 
opens on the right side. 
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Fig. 3-51: Configuration of "Object", view in the rider "Configure" 
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Additional options in the rider "Configure" 

Menu Item Description 

Object 

└─Create This flag indicates whether the object has been created or not. It 
is primarily intended to prevent the creation of native objects. By 
default, all objects are created. 

Supported Services 

└─COV Server Indicates whether the object accepts COV subscriptions for the 
Present_Value (by default and recommendation: select) 

└─COV Property  
      Server 

Indicates whether the object accepts COV subscriptions for any 
properties of an object (by default, "Yes") 

└─Alarm Generator Enabling/disabling of object alarming ("Intrinsic Reporting") 

List of object properties 

└─Acc Display of the possibility of access ("Access") to properties via a 
lock symbol: 

Access allowed (can be changed by clicking on symbol) 

No access allowed (can be changed by clicking on symbol)

Access allowed; cannot be changed since required by 
BACnet Standard 

No access allowed; cannot be changed since required by 
BACnet Standard  

└─Mod In this column, an arrow symbol is used to indicate whether a 
standard value/default value has changed ("Modified").  

 The property has been changed or been newly added 
(green). 

Note 
If the arrow is set, the values from the configuration 
are used and will over-write the runtime values that 
were transferred using "Commit Values." 
If no arrow is set, the runtime values for the 
corresponding property are also retained after the 
configuration is written. 
By clicking on the green arrow symbol, all the 
changes are reset and the arrow symbol is deleted.  
From that point, the values transferred to runtime 
using "Commit Values" are used. 

 The property has been changed but cannot be reset 
(gray)  

└─Internal Mappings Display of the IEC variable on which the property is mapped. 
Clicking on a field in the column "Internal Mappings" opens the 
"IEC Mapping Editor". 

└─Client Mappings Indicates whether there is a "Client Mapping" for the given 
variable or not. 
Clicking on a field in the column "Client Mappings" opens the 
"Client Mapping Editor". 
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Right clicking on the list of object properties will give you a context menu 
(see Fig. 3-52).  

 
Fig. 3-52: Properties context menu 

The context menu will give you the following selection possibilities: 

Menu Item Description 

Rescan Object Updating the object 

Expand All Expansion of all folders 

Collapse All Collapse of all folders 

Add Property Addition of a valid object property 

Remove Property Removal of an optional property 

Reset Value Resetting of a property value to the default value 

Add Element Addition of an element or field if the property is a field or a list 

Add Elements... Insertion of several elements; otherwise, like "Add Element" 

Remove Element(s) Removal of an element 

Copy Value Copying of a property value 

Paste Value Insertion (replacement) of a property value 

Paste Value as new Add a new list element with the copied value (e.g. with the prop-
erty "Data List" of the Calendar Object) 

Client Mappings... Opening of the "Client Mapping Editors" (see Section  3.2.4.3.1) 

Internal Mappings... Opening of the "IEC Mapping Editors" (see Section 3.2.4.3.2) 

Auto-Size Column Widths Automatic setting of the optimal column width 
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3.2.4.3.1 Client Mapping 

Client Mappings are mappings/links of one property or variable to a property 
in another (or, if desired, to the same) device. 

Both IEC variables and BACnet properties of objects of a device can be linked 
in the BACnet Configurator with the BACnet properties of objects of other 
devices. These links can be configured. 

• "Read Maps" on a device A (client) read values of BACnet properties in 
another device B (server) and writes these values in IEC variables or 
BACnet properties in device A; reading of the value can therefore take 
place at regular, definable time intervals or only with a change in value. 
Reading the value with each change in value (COV - Change Of Value) 
functions via a subscription mechanism (COV Subscription) and must be 
supported by device B. In this case, subscriptions are renewed at time 
intervals that can be set. 

 
• "Write Maps" on a device A sends values of BACnet properties or IEC 

variables to BACnet properties in another device B. 
 
For REAL values, an optional, minimum increment can be established by 
which the absolute value of the value must change before a value change is 
forwarded. 

The Client Mapping Editor is not modal and indicates editable configurations 
of associated Client Mappings for just enabled properties. 

You can find an example for the creation of Client Mappings in section 4.3, 
"Creating a Client Mapping". 

 
Fig. 3-53: Client Mapping Editor 
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Menu Item Description 

List of available links 

└─Type Type of link, reading or writing 

└─Remote Property Remote property linked with the local property via Client 
Mapping 

Parameters 

└─Write Priority Setting the write priority 

└─Poll Cycle Setting of the time interval for requests if no COV is supported (in 
seconds) 

└─Real Increment    
     Threshold  

For real-valued properties, the value by which the property value 
must change so that it is updated 

COV 

└─Use Subscriptions Use of transmission during value change (Change of Value) � "If 
available", "Never" or "Always" 

└─COV Expiry  Time in seconds after which a subscription to changes of value in 
a remote property expires 

Such subscriptions are set up and managed by the BACnet 
services SubscribeCOV or SubscribeCOVProperty. 

└─Request Confirmed  
      Notifications 

COV notifications can be either "confirmed"  
(recipient confirms receipt to the sender) or "unconfirmed" 
(without notification to the sender).  
If the sender receives no confirmation for "confirmed" 
notifications, it usually resends the report one or more times until 
it receives a confirmation of receipt. 

[Add Read Map] The controller that has just been configured executes read access 
of the remote property. 

 [Add Write Map] The controller that has just been configured executes write access 
of the remote property. 

 [Delete Map] Deletion of selected link 

 [Close] Closing of the dialog 
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3.2.4.3.2 Internal Mapping (IEC Mapping) 

Internal Mapping is understood as the assignment of BACnet properties to 
IEC variables that are not BACnet properties. You can also carry out this 
assignment later with any IEC variables.  

You import the SYM_XML file inside the rider "Configure:<device name>" 
(cf. Fig. 3-36). There is no provision for adding a variable here. However, you 
can assign variables that are not assigned to any property in the SYM_XML 
file. 

You can find an example of the creation of Internal Mappings in section 4.4, 
Creation of Internal Mappings. 

 
Fig. 3-54: Internal Mapping in the IEC Mapping Editor 

Menu Item Description 

Name Name of the IEC variable (from the SYM_XML file) 

Type Data type of the IEC variable (from the SYM_XML file) 

Mapped to Property Name of the BACnet property with which the IEC variable is 
linked 

[Set Mapping] Creation of a link 

[Delete Mapping] Deletion of a link 

[Close] Closing of the dialog 
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3.3 Online and Offline Status 
The BACnet Configurator has two main modes for the configuration of a 
WAGO BACnet/IP Controller 750-830: 

• Online configuration mode (with the controller connected to a BACnet/IP 
network) 

• Offline configuration mode 

In both modes, the following actions can be carried out: 

• Importing the SYM_XML 
Note: If an SYM_XML file is imported in the online mode for a 
controller, then this has precedence over every other SYM_XML file of 
the controller 

• Importing/exporting the Override file 
Note: If an Override file is imported in the online mode for a controller, 
then this has precedence over every other Override of the controller 

• Importing/exporting of BACnet EDE files  

• Processing of native, SYM_XML- and Override-defined BACnet objects: 

• Addition and removal of Override-defined objects. 
• Addition, changing and removal of optional properties  
• Enabling/disabling of "Intrinsic Reporting" 
• Enabling and disabling of the reporting of changes in value 

(SubscribeCOV and SubscribeCOVProperty service) 
 

• Editing of Client Mapping (between BACnet properties)  

• Editing of Internal Mapping (between IEC variables and BACnet 
properties) insofar as IEC variables are not already permanently linked 
with a property via SYM_XML. 

In the online configuration mode, you can also carry out the following actions: 

• Downloading of the configuration files SYM_XML and Override 

• Uploading of the configuration files into a BACnet device using backup 
and restoration procedures 

• Carry out a search for BACnet devices and their objects which are present 
in the network 

• Reading and writing of property values for each BACnet device in the 
BACnet/IP network. 
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• Backup and restoration for all BACnet devices that support these 
procedures 

• Restarting of BACnet devices in the BACnet/IP network 

• Enabling/disabling of BACnet communication between BACnet devices in 
the BACnet/IP network  

• Synchronization of the time of BACnet devices in the BACnet/IP network 

• Creation of the services for Life-Safety-Point and Life-Safety-Zone objects 
in BACnet devices in the BACnet/IP network 

• Addition and deletion of list entries in Recipient_List properties of the 
Notification-Class objects in BACnet devices located in the BACnet/IP 
network 
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3.4 Software Deinstallation 
1. Click on the entry Software under Start > Settings > System Control. 

2. Choose the entry "WAGO BACnet Configurator" and click on the button 
[Remove]. 
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4 Example Configuration 
In the following, some configuration possibilities are described, for example 
the search for devices in the network, the editing of found devices and objects, 
the loading of the configuration to a BACnet/IP controller or the creation of a 
Client Mapping and Internal Mapping. 

4.1 Configuring New Devices 
Link the WAGO BACnet/IP controller to your network. The controller has a 
default IP address through DHCP. 

Configure the device with the BACnet Configurator: 

1. Open the BACnet Configurator. 

As long as the button Device Auto Discovery is enabled (highlighted in 
color), new devices are searched for at regular intervals and the list in the Scan 
pool is updated (see Fig. 4-1).  
 

 
Fig. 4-1: Automatic device search disabled (left) or enabled (right) 

You can change the interval for the search through Extras > Options. 

The progress bar at the lower right shows you the status of the search. 
As an alternative, you can conduct the network scan using the button "Scan 
BACnet" (magnifier). 

A newly found device is presented with its standard values and standard 
instance number in the "Scan" pool. 

2. Click on the "+" in front of the device in the "Scan" pool. 

Below the device, different folders are displayed (see Fig. 4-2). The folder 
"Device" contains the Device Object of the device. The folders "Inputs" and 
"Outputs" are created for the modules connected to the device, which are 
represented by native objects. Even more folders are possible, such as "Files" 
for SYM_XML and Override files. 
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Fig. 4-2: Device with its objects 

3. Choose Configure in the context menu of the device to configure the 
device. As an alternative, choose Device > Configure in the main menu or 
use the button [Configure] to the right in the window (see Fig. 4-3). 

 
Fig. 4-3: Three possibilities for configuring a device 

The configuration area with the rider "Configure:<Unnamed>" is opened. Any 
available configuration data from the device is uploaded and displayed.  
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Add two objects to the device:  

4. Click with the right mouse button on the Device Object and select Add 
Object > Schedule and Add Object > Calendar in the context menu. 

 
Fig. 4-4: Add objects using the context menu  

You need the Calendar Object to be able to indicate exception dates for certain 
actions in later steps. 

5. Also choose the Alarm-Server Object using Add Object > Notification 
Class to generate alarms with some of the native objects below.  

The three objects are added to the list and can continue to be configured (see 
Fig. 4-5). 

 
Fig. 4-5: Newly created objects 
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6. Select the Schedule object in the tree to the left or in the object list to the 
right; this will open the detail view of the object in the configuration area. 

The Schedule object contains, by default, a weekly programmable schedule 
"Weekly Schedule", but no exception rules for the "Exception Schedule" yet, 
which is used for holidays, for example. 

7. Click with the right mouse button on the list of object properties and 
choose Add Property > Exception Schedule in the context menu (see 
Fig. 4-6). 

 
Fig. 4-6: Adding properties 

8.  Also add a description using Add Property > Description. 

The newly added properties can be further configured. 
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9. Click with the right mouse button on Exception Schedule and choose 
Add Element. 

 
Fig. 4-7: Adding elements 

A new element "[1]" is displayed below the "Exception Schedule". 

 
Fig. 4-8: New element 

10. Holidays will serve as the exception rule in relation to the calendar in this 
example. To this end, choose the type "Calendar Reference" under Period. 

 
Fig. 4-9: Defining the calendar 

11. Confirm your entry with Enter. 

Below "Period", additional points are displayed: "InstanceNumber" and 
"Type". 
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12. Under Type choose the desired calendar, e.g. "CALENDAR (6)" and "0" 
as the InstanceNumber. 

 
Fig. 4-10: Changing entries in elements 

In the "ListOfTimeValues", enter the exception times: 

13. Right click on ListOfTimeValues and choose AddElement in the context 
menu. 

 
Fig. 4-11: Changing entries in elements 

A new element "[1]" is displayed below the "ListOfTimeValues". 

Assign certain values to certain times for the exception times in the calendar: 

14. Next, enter "Real" under Type and then the value "10" under Value. 

 
Fig. 4-12: Entering values in the calendar 
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15. "Time" is used to set the time at which the exception is to apply, for 
example "00:10:00:00" in order to define a switching point at 0:10. 

 

Note 
If you want to define day-to-day switching times, then 00:00:00:00 must be 
defined as extra switching point.  
Example: Switching on the light at 20:15 in the evening, switching off the 
light at 7:30 in the morning on the next day: 
On  [1] Monday 20:15:00:00 
On  [2] Tuesday 00:00:00:00 
Off  [2] Tuesday 07:30:00:00 

16. Using EventPriority enter the priority of the exception rule, e.g. "1" for a 
low priority. 

In the "Weekly Schedule", enter certain values as the event for starting an 
action for each weekday. Seven schedules, from Monday [1] through Sunday 
[7], can be created per week. Here, you enter the values in the same way as for 
the exception rule "Exception Schedule" (see point 14 and 15). 

To enter holidays, add elements in the date list in the Calendar object: 

17. Choose the Calendar Object in the tree to the left. 

18. Click with the right mouse button on the property Data List and add an 
entry "[1]" using Add Element (see Fig. 4-13). 

 
Fig. 4-13: Adding holidays 

Tip: To create several entries at the same time, click on Add Elements and 
select the desired number of new elements in the display (see Fig. 4-14). 

   
Fig. 4-14: Adding several new elements 

19. Click on the entry "[1]" and enter the date "2008-12-24-3" as the value and 
"E_DATE" as the Type (see Fig. 4-15).  
Format of the date: 
YYYY-MM-DD-W 
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wherein the last number represents the day of the week (1 � Monday 
through 7 � Sunday) 
 
For each field, "*" may be used as a wildcard, e.g. 2008-12-*-* for all days 
in December 2008. As an alternative, an editor can also be used, which 
you can open by clicking in the data field and on the button [...].  

  
Fig. 4-15: Entering an exception date 

You have now defined exception rules, schedules and holidays in order to 
trigger particular switching time actions.  

To generate alarms as shown below, use the already added notification class 
object as well as the alarm generators, which generate the alarms. Analog-
Input Objects are used as alarm generators, for instance: 

The alarms are sent to those recipients whom you define using the Notification 
Class Object: 

20.  Select the Notification Class Object in the tree to the left. 

21. Click with the right mouse button on Recipient List and select Add 
Element(s) to add new recipients to the recipient list for the object's 
alarms (see Fig. 4-16). 

 
Fig. 4-16: Entering new recipients for alarms 
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A sub-element "[1]" is inserted. It represents a new recipient, which is further 
configured (see Fig. 4-17). 

 
Fig. 4-17: Configuring new recipients 

Note: Usually, recipients enter themselves through the network.  

Now, configure the alarm generator (e.g., analog input object): 

22.  Click on Analog Input to the left in the tree. 

23. Select Add Property > Notification Class in the context menu of an 
object property to add the property "Notification Class" to the object (see 
Fig. 4-18). 

 
Fig. 4-18: Adding the property "Notification Class" to the Analog Input Object 
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The property "Notification Class" automatically expands the object to include 
all properties that are necessary for alarm generation. These properties are 
indicated with a green symbol since these are optional properties (see Fig. 
4-19). 

 
Fig. 4-19: New properties when adding the property "Notification Class"  

The alarm generation is configured via the added properties. 

These settings are also possible online if an Alarm Client writes the properties. 
In this example, however, you are determining static values for the time being: 

24. Enable the entry "HIGH_LIMIT_ENABLE" under Limit Enable and 
disable the entry "LOW_LIMIT_ALARM". With this action, only upper 
limits are allowed (see Fig. 4-20). 

 
Fig. 4-20: Enabling and disabling the properties 

25. Enter the value "100" under High Limit as the upper limit. 

 
Fig. 4-21: Entering values 

All input and output objects can function as alarm generators if the property 
"Notification Class" is added. Alarms that are triggered in the Input and 
Output Object are sent to the recipient list in the Notification Class Object. 

26. Click on the button [Store and Download] to apply the configuration and 
store it in the memory. 
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A dialog in which the device is displayed is opened, and you configuration is 
loaded to this device. The device address is made up of the network number, 
the IP address and the BACnet MAC address together, each separated by a 
colon (see Fig. 4-22). 

 
Fig. 4-22: Uploading the configuration 

27. Enable Reset device after download and enter a password (if necessary) 
to restart the device after downloading the configuration. 

28. Click on [Download Configuration]. 

Check whether the configuration was successful: 

29. Change over to the rider "Browsing & Monitoring". 

30. Click on Rescan Device in the context menu of the configured device 
(Scan pool) to read in only this device again (see Fig. 4-23). 

 
Fig. 4-23: Updating the device via "Rescan device" 
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The view is updated. Under the configured device, you will see additional 
folders, such as "Schedules" and "Alarms", in which the objects "Calendar", 
"Schedule" and "Notification Class" that you have previously configured are 
contained (see Fig. 4-24). 

 
Fig. 4-24: New folders for "Schedules" and "Alarms" 

In the Analog Input Object, which you have configured to an alarm generator, 
you will see all the properties necessary for alarm generation in the 
configuration mode. 

If "Monitoring" is enabled, you will have a current view of the data in the rider 
"Browsing & Monitoring". Live values that you can change during the runtime 
are displayed. In the rider "Configure", on the other hand, the values are static 
and are not updated. 

Now change one of the live values and transmit this directly to the controller: 

31. Click on the configured device to the left in the tree. 

32. Click on Analog Input_0 in the folder Inputs. 

33. Enter a new value "500" for the property High Limit, which you 
configured under point 25. 

34. Using [Commit Values], transmit the value directly to the controller.  

 
Fig. 4-25: Transmitting values directly via "Commit Value" 
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If the write process is successful, the property is marked in green and the 
"Write Status" is set to "OK" (see Fig. 4-26).  

 
Fig. 4-26: Successful value transmission 

If the write operation fails, an error message is displayed under "Write Status". 
The property is marked with red.  

It is possible to change several values and transmit them together. 

35. Set Time Delay to "10" and Deadband to "10". 

Both "Time Delay" and "Deadband" are then highlighted in orange. 

36. Transmit both value changes together via [Commit Value].  

After the transmission, both are marked in green and have the status "OK". In 
this way, for example, data from other manufacturers that cannot be stored in 
the database can also be easily changed (see Fig. 4-28). 

 
Fig. 4-27: Transmission of several values 
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Fig. 4-28: Several values successfully transferred, status OK 
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4.2 Working with Persistent and Configured Values 
Object property values are stored differently depending on the type of change:  

1. Change made to the runtime in the "Browsing & Monitoring" rider 
Existing property values are changed here, transferred in the controller to 
the runtime using [Commit Values] and persistently saved there. Changes 
to the runtime are only possible if access to this property is permitted in the 
"Configure" rider (  symbol). 

2. Configuration performed in the "Configure" rider 
Objects and their properties are created, changed or deleted here. Changed 
properties are identified with an arrow symbol . These values are loaded 
into the controller using [Store and Download] and will overwrite 
existing persistent data. Unconfigured standard values (without arrow 
symbol) will not overwrite the persistent values.  

In the following, the interplay between persistent and configured values is 
explained by three property values of the Analog Value Object. 

1. Open the "Configure" rider. 

Consider the following properties of the standard configuration as examples: 

Name Value Acc Mod 

COV Increment 0   

Deadband 0   

Low Limit 0   

 

2. Change two of the values and click on one of the lock symbols in the 
"Acc" column. This will lock this value from being changed in the 
runtime. 

Name Value Acc Mod 

COV Increment 10   
Deadband 20   
Low Limit 0   

 
Changed values ("Value") or permitted/blocked access ("Acc") are identified 
as modified in the "Mod" column with an arrow. 

3. Click on the button [Store and Download] to download the configuration 
and store it in the controller. 

4. Change over to the "Browsing & Monitoring" rider. 
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5. Click with the right mouse button in the "Scan" pool on the device with the 
changed values and select "Rescan selected Device(s)" in the context 
menu. 

The following life values from the previous configuration are displayed: 

Name Value 

COV Increment 10 

Deadband 20 

Low Limit 0 

 

6. Change the life values of the properties:  

Name Value 

COV Increment 100 

Deadband 200 

Low Limit 300 

 

7. Click on the [Commit Values] button to transfer the values to the runtime 
into the controller.  

The changes for "Deadband" and "Low Limit" are taken over. "COV 
Increment" is not changed since you have blocked this property in the 
"Configure" rider (red lock): 

Name Value 

COV Increment 10 

Deadband 200 

Low Limit 300 

 

8. Change in the "Configure" rider. 

You are shown the last configuration: 

Name Value Acc Mod 

COV Increment 10   
Deadband 20   
Low Limit 0   

 

9. Download this configuration again using [Store and Download] into your 
controller. 
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10. Change over to the "Browsing & Monitoring" rider. 

11. Click with the right mouse button in the "Scan" pool on the device with the 
changed values and select "Rescan selected Device(s)" in the context 
menu. 

The values for "COV Increment" and "Deadband" were taken over from the 
configuration. The value for "Low Limit" was not changed in the 
configuration (no arrow symbol). For this reason, the persistent value that was 
transferred to the runtime using "Commit Values" is shown here: 

Name Value 

COV Increment 10 

Deadband 20 

Low Limit 300 
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4.3 Creating a Client Mapping 
1. Open the rider "Configure". 

2. Choose an object in the "Inputs" folder, e.g. Analog Output 0. 

3. Right click on a property and choose Client Mappings... (see Fig. 4-29). 

 
Fig. 4-29: Opening the Client Mapping Editor 

The Client Mapping Editor is opened in a non-modal dialog.  

4. Select the object Analog Output to the left and the property Present 
Value to the right in the main window.  

The Client Mapping Editor indicates the existing linkable properties for the 
currently selected property in the main window. 

Now, the property "Present Value" of the "Analog Input" of a local device is 
supposed to be read and written to the "Present Value" of the local object 
"Analog Output": 

5. Choose a device in the Client Mapping Editor. 
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6. Select the object Analog Input underneath the device and the property 
Present Value below that (see Fig. 4-30). 

7. Now link the Present Value of the selected Analog Input Object in the 
Editor with the Present Value of the local Analog Output Object 
selected in the main window by clicking on [Add Read Map] (see Fig. 
4-30). 

 
Fig. 4-30: Non-modal Client Mapping Editor 

The link is displayed in the dialog to the right (see Fig. 4-31). 

 
Fig. 4-31: Successful linking in the Client Mapping Editor 
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The created link is further parameterized 

8. Choose the setting "If available" under Use Subscription.  

With this setting, only changes in value are transmitted (COV). If no COV is 
possible, values are transmitted by "Polling". The time interval for polling is 
established using the "Poll Cycle": 

9. Select a Poll Cycle of 3 seconds, for example.  

10. Then click on [Close] and close the Editor. 

11. Click on [Store and Download] to store the Client Mapping and load it to 
the controller or continue with the configuration. 
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4.4 Creating an Internal Mapping 
In the following, you will create links between BACnet properties and IEC 
variables. 

1. Open the rider "Configure". 

2. Choose the device in the tree to the left.  

3. In the configuration area, click beside the input field SYM_XML on the 
button [Import] (see Fig. 4-32). 

 
Fig. 4-32: Importing a SYM_XML file 

4. Open the SYM_XML file.  
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Below the device, the new objects that are defined in the SYM_XML file are 
displayed in a folder labeled "IEC Variables" (see Fig. 4-33).  

 
Fig. 4-33: Importing a SYM_XML file 

5. Click on the device to the left in the tree. 

On the right side, four new riders will open: �Device�, �IEC Variables�, 
�BBMD� and �IP Settings�. 

6. Click on the rider "IEC Variables" 

You will see all IEC variables of the SYM_XML file. In the SYM_XML file, 
whole objects are also defined. Variables that belong to these objects and are 
therefore already linked can no longer be bound with other properties using 
the BACnet Configurator.  

BACnet properties that are not permanently bound with IEC variables in the 
SYM_XML file can be linked, however. 

7. Click with the right mouse button on an IEC variable that can be linked 
(Mapable: "Yes") and click on the button [IEC Mappings] in the toolbar. 

A non-modal dialog is opened. 

8. In the tree of the main window, click on Analog Output and select, for 
example, the property Out of Service. 

The IEC Mapping Editor displays a selection of IEC variables that can be 
bound to the selected property. 
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9. By using [Set Mapping], link Out of Service of the Analog Output 
Object with a selected IEC variable of the IEC Mapping Editor (see Fig. 
4-34). 

 
Fig. 4-34: Internal Mapping 

The bound property is displayed behind the IEC variable under "Mapped to 
Property".  

10. Click on the device to the left in the tree and on the rider "IEC Variables". 

The BACnet property ("Out of Service") bound to the IEC variable 
("Max_Alarm_Values") is displayed again under "Mapped to Property". 
(siehe Abb. 4-35). 

 
Abb. 4-35: Internal Mapping successful 

11. Click on [Store and Download] to store the Client Mapping and load it to 
the controller or continue with the configuration. 
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